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Prelude

Thank you for choosing Gainserver.com as your business server partner. We want to

ensure that you can utilize all the features we provide to advance your trading

business.

So, get ready to follow this guide and make sure you have received your server

credentials. This guide will help you right from the very beginning.

If you do not yet have our services, please follow the instructions from our

partner to receive our full service and support.
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Automate System?

This is a KEY feature of our trading servers. The system comes with active configurations set by

default, and there are parts that you need to activate. Don't worry, even if you're a beginner, the

process is very simple.

—-

1. Remote Server

First, remote into your server using the credentials you have received.

Search for the program in Windows: Remote Desktop Connection.
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When the program opens, it will look like the image below. Click the Show Options button.

The Remote Desktop Connection window will appear with more options to configure your remote

session, as shown below:
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Computer: Input Server IP Address.

User name: Input Your Username.

Checked Allow me to save credentials

Next, click Save As to save the remote

configuration as an RDP file.

Use this RDP file to access your server again.

Click the Connect button to start your remote

session.
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When connected, you will be prompted to enter the default password you received from us via

email. Enter this password in the Enter your credentials windows.

Then, follow the instructions to change your password before accessing your server.

Click "OK" to follow the instructions for changing your password.
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Strength Password Required

Use a minimum of 10 characters, including lowercase

letters, uppercase letters, and special characters.

KEEP YOUR PASSWORD SECURE.

Password : Input default password.

New password : Input new password.

Confirm password : Input new password again.

Press the Enter key or click the arrow button.
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Notice the server display above, highlighting the menus we marked with a green box. You will

begin working with these menus.
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—-

2. Using as Trading Server

After successfully accessing the server for the first time, the system will automatically activate

crucial features for trading activities. Let us guide you through the first steps of using our trading

server.

Now, focus on the menus we mentioned earlier. Open the ‘MENU’ folder, and you will find the

following contents:
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You will see several menus, which you can explore at your leisure. For now, we will guide you to

highlight the "AUTOMATE ACTIVATION" folder. Please open this folder.

There are 4 menus that we have arranged to help you get started easily.
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1. Webhook API Notification

This tool integrates everything, with the webhook providing server interaction through messages

sent to your email, WhatsApp, or Telegram.

Each webhook is a unique URL tailored for each customer.

Webhook format is https://api.gainserver.com/id-webhook-unique.

If you selected the Addon Webhook API during your order, open the Webhook API

Notification folder, you will find a file inside: setup_webhook_api_url_here.txt

Open the.txt file and copy-paste your complete Webhook API URL.
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The contents of the setup_webhook_api_url_here.txt file will look like the example above.

Press Ctrl + S or click File > Save to save your Webhook URL configuration.

✅ SETTING WEBHOOK DONE
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2. WinAutoLogin Activation

This activation allows the server to automatically run MetaTrader during the startup process. It

provides a quick way to restart MetaTrader without the hassle of re-logging in and starting the

program manually.

Open the WinAutoLogin Activation folder and run the program:

WinAutoLoginActivation.exe.
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If your password meets the standard, continue by typing 'N'. If your password is still weak or has

an easily guessable pattern, we highly recommend following the WinAutoLogin activation by

changing your password first. To do this, type 'Y' to follow the password change prompts.

We assume you will not need to change your password again, as you already set a strong

password during the initial remote session.

Type 'N' and press Enter. Then, follow the next instructions:
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Enter the administrator username: input server username, press Enter

Enter the password: input server password, press Enter

Verifying password...

Enter the password for username: input server password again, press Enter

If the username and password are verified, the "Next step" window will appear as shown below:

Type 'Y' and press Enter to proceed with the activation.
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The operation completed successfully.

WinAutoLogin has been successfully activated. Thank you for using our

services!

If the information above appears, your activation has been successful.

✅ WINAUTOLOGIN ACTIVATION DONE
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3. MetaKeeper Watchdog

MetaKeeper is a tool developed using Meta Language (MQL) to help monitor and reconnect live

trading accounts in case of issues.

Did you know? Various potential issues such as chart freezes, login disconnections, and broker

server problems can cause your live trading account to disconnect.

When a disconnection occurs, all your trading activities and robots come to a complete stop. With

MetaKeeper, this condition will be monitored.

First, MetaKeeper will attempt to reconnect to your broker's server and ensure the account

successfully logs in.

Second, MetaKeeper will send alerts or messages via email, WhatsApp, or Telegram. This will

help you stay informed about the server status in real-time, even at the MetaTrader program

level.
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Start using MetaKeeper…

1. Easy Steps to Download & Install MetaKeeper

Open the MetaKeeper Watchdog folder and run the MetaKeeper.exe program. This

application will install the "MetaKeeper.ex4" file to all pre-installed MetaTrader 4 instances on

your server.

Your installation is successful if the following information appears: CONGRATULATION,

METAKEEPER.EX4 INSTALLED SUCCESSFULL.

Instructions for running MetaKeeper.ex4 can be found in Section 3 below.

✅ METAKEEPER INSTALLATION DONE
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4. LogMan

The last folder in the AUTOMATE ACTIVATION menu is LogMan.

LogMan is a performance monitoring feature that periodically monitors the utility of your trading

server. LogMan works in conjunction with the Webhook API Notification to send overload alerts to

your email, WhatsApp, or Telegram. This feature is very powerful.

By default, the LogMan system is enabled on your trading server. This folder is useful if, in certain

cases, you need to stop or restart the LogMan service. There are STOP and START LogMan

buttons available.

Here is the CPU overload message:
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Here is the Memory overload message:

—-

3. Running your Expert

This is the third step in using our server. After activating Automate (Section 2), you are now ready

to start using MetaTrader on our server.

Refer to the menus displayed on the server desktop. You will find a folder named "Pre-installed

Metatrader". This folder contains pre-installed MetaTrader 4 and MetaTrader 5 folders.
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What is the function of the pre-installed MetaTrader?

The pre-installed MetaTrader is already set up for you, so you don't need to go through the hassle

of installing the MetaTrader program yourself.

What are the advantages of the pre-installed MetaTrader?

The pre-installed MetaTrader is the basic program you're familiar with. To make MetaTrader

easier to back up and to avoid using the Windows installation system, we have implemented the

portable version for all pre-installed instances on the server.

Our lab engineer's research shows that this portable version of MetaTrader runs lighter and more

powerfully than the normal installation version, without compromising any of the MetaTrader's

functions.

Another advantage is that we have developed a Cross-Connect system within the server. This

system isolates each use of our portable MetaTrader into single-thread processing. As a result,

the pre-installed MetaTrader uses fewer CPU resources.
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1️⃣ Running Experts OnMetaTrader 4 + MetaKeeper

If you are using MT4, first run the pre-installed MetaTrader 4 and log in to your broker's server.

Scan Broker’s Server (MetaTrader 4 File > Open an Account):

1. Enter the name of the broker's server you are using. Make sure you get the correct server

name according to the broker's entity. For example: FBS Markets.

Before scanning the server:
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After scanning with the keyword: FBS Markets

2. Once you have found the server name (server number) and the Ping column displays the

milliseconds (ms), click on that server and then click the Next button. Next, enter your trading

account Login and Password, and then click the Finish button.
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After successfully logging in and before activating your EA, first run MetaKeeper.ex4. Here are

the instructions for running MetaKeeper.ex4:
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1. Make your trading account a favorite by right-clicking on the trading account and selecting the

Add to favorites option. Refer to the image below:

2. Go to the MetaTrader 4 menu Tools > Options, and select Expert Advisors tab menu,

perform the following settings:
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1. ✅ Checked Allow automated trading

2. Unchecked all options below:

- ❌ Disable automated trading when the account has been changed.

- ❌ Disable automated trading when the profile has been changed.

- ❌ Disable automated trading when the chart's symbol or period has been changed.

3. ✅ Checked Allow DLL imports.

4. ✅ Checked Allow WebRequest for listed URL, and input your Webhook

Notification URL (domain or subdomain depending on the URL you received).
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3. Attach MetaKeeper.ex4 to just one chart and set the timeframe to 1 Minute.

For example, use the EURUSD chart with a 1 Minute (M1) timeframe. Then go to the Inputs

configuration tab.

4. In the Inputs configuration of MetaKeeper, focus on the following settings:

AccountRow: Set to 1 (Use this default).

Delay in Minutes: Set to 5 (Recommended, this is the delay MetaKeeper uses to update monitoring).

Webhook Notification Url: ​​Input the Webhook API URL you received.

Your server IP Address for notification: ​​Input your server's IP address.

Offset your time to server time: Input the difference between your timezone and the

broker's timezone.

5. Click OK when done.
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MetaKeeper will display the status on your chart as follows:

MetaKeeper will also send messages to the email, WhatsApp, or Telegram account you use:

Congratulations, MetaKeeper is running in your terminal.

The account that monitors is the one that activates MetaKeeper. Therefore, if you run multiple

accounts, it's advisable to activate MetaKeeper on all your trading accounts to ensure they are all

monitored.

29



Once MetaKeeper is active, your next step is to run your EA as usual. MetaKeeper will function

solely to monitor the status of your trading account and does not have trading capabilities. This

allows you to run other EAs on the account with MetaKeeper without any issues.

2️⃣ Running Experts On MetaTrader 5

If you are using MT5, run the pre-installed MetaTrader 5 as needed.

1. Scan for your broker. The instructions for scanning the broker server are the same as for

MetaTrader 4.

2. Log in to your trading account with the appropriate server.

3. Run your expert advisor (EA) as you normally would.
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3️⃣ Running MetaTrader On StartupWindows

This section guides you on how to ensure that all MetaTrader instances, both MT4 and MT5,

have the capability to auto-open during Windows startup. This feature is crucial and beneficial

in the event of force majeure, unexpected issues, or simply a server reboot. All MetaTrader

terminals can open automatically, allowing your trading activities to recover quickly.

How to Enable Auto-Open on Startup?

We have provided a Startup menu on your server desktop. By default, this folder is empty. All

you need to do is copy the shortcuts of the pre-installed MetaTrader from the "Pre-Installed

MetaTrader" folder and paste them into the Startup folder.
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Label the MetaTrader shortcuts clearly, as shown below:

In the example above, there are four MetaTrader instances running. We copy-pasted the

shortcuts of these four instances into the Startup folder so that they have the capability to

auto-open.
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Here are the files that have been copied to the Startup folder:

IT'S EASY, ISN'T IT?

Should all pre-installed programs be copied to Startup? NO, DEFINITELY NOT.

Only the ones you run need to have the Auto Open capability.

By following the above steps, you are now running your trading business using an EA on a server

with our Automate System capabilities.
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4. Server Monitoring & Analyzing

1. Task Manager Monitoring

Use Task Manager to monitor your server's CPU and Memory usage.

2. CPU Overload Logs

CPU Overload logs can be used to investigate and analyze when the server experiences

overload, how often it occurs, and to what extent (percentage). This information will help you

decide whether an upgrade to your package is necessary.

3. Memory Overload Logs

This file is similar to the CPU logs mentioned above but is specifically for monitoring memory

overload.
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4. Logon Logs

Every login made through Remote Desktop will be recorded in this log file. You can analyze this

further if needed for security reasons.

5. Reboot Logs

The reboot log will detect the last time the server was rebooted or experienced a reboot caused

by the provider. The log will display the user who performed the reboot. This can be used for

further analysis to maintain server security.
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Thank you

We hope this information is useful and helps ensure your success.

In addition to the main guide above, our server is also equipped with ADDONS, TOOLS, and

other TRADE UTILITIES to support your trading business. To learn more, follow our information

journal through the following media:

https://t.me/gainserverchannel

Save our contact, support@gainserver.com, in your Gmail or other email provider's contact list to ensure

you don't miss any important updates we release.

Want to buy me a coffee☕ ?

😉
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